
Apresentação do R com um exemplo de análise de regressãonão-linear∗Eduardo Esteves26 de Março de 2009Instituto Superior de Engenharia, Universidade do Algarve, Campus da Penha, 8005-139 Faro eCentro de Ciências do Mar, Laboratório Associado, Campus de Gambelas, 8005-139 Faro; E-mail:eesteves@ualg.pt URL http://w3.ualg.pt/ eestevesResumoNo seguimento dum artigo anterior acerca da análise de regressão não-linear (simples) utili-zando a ferramenta Solver® do Excel® (Esteves, 2008) propõe-se neste artigo a apresentaçãodo R, uma linguagem de programação e um ambiente para computação estatística e grá�ca,através da sua aplicação na �descrição� de relações estatísticas (não-lineares) entre variáveis.Palavras-chave: R, Regressão não-linear.IntroduçãoO R (R Development Core Team, 2007) é ao mesmo tempo uma linguagem de programação e umambiente para computação estatística e grá�ca. Trata-se de uma linguagem de programação es-pecializada em computação com dados. Uma das suas principais características é o seu caráctergratuito e a sua disponibilidade para uma gama bastante variada de sistemas operativos (vd.http://www.r-project.org). Apesar do seu carácter gratuito, o R é uma ferramenta bastante pode-rosa com boas capacidades ao nível da programação e um conjunto bastante vasto (e em constantecrescimento) de packages que acrescentam bastantes potencialidades à já poderosa versão base doR (Torgo, 2006). Contudo, o termo �ambiente� pretende caracterizar o R como um sistema com-pleto e coerente ao invés dum conjunto de ferramentas muito especí�cas e relativamente in�exíveis(Venables et al., 2006).O R pode ser entendido como uma implementação da linguagem S desenvolvida por RickBecker, John Chambers e Allan Wilks nos Bell Laboratories (E.U.A.), que também constituia base do software S-Plus® (Insightful Corp.). A evolução da linguagem S está descrita emquatro livros de John Chambers e colaboradores. As �distribuições� do R incluem um bom con-junto de manuais (vd. http://cran.r-project.org/manuals.html) e existem, actualmente, várioslivros que descrevem a utilização do R para análise estatística de dados (vd. http://www.r-project.org/doc/bib/R-books.html), e.g. Dalgaard (2002). Foi disponibilizada recentemente (em
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22/4/2008)1 a versão 2.7.0 do R (embora neste artigo se utilize a versão 2.5.0). O �cheiro deinstalação (R-2.7.0-win32.exe) para Microsoft Windows® pode ser obtido em http://cran.at.r-project.org/bin/windows/base/R-2.7.0-win32.exe. A instalação é simples. Também existem �ver-sões� para Mac OS e Unix/Linux. O sítio electrónico do projecto constitui a principal referênciado R e funciona como ponto de partida para explorar mais este sistema.Boa parte das pessoas utiliza o R como um sistema para análise estatística de dados, uma vezque a maioria das �estatísticas clássicas� e muitas das metodologias mais recentes estão disponíveis,embora os promotores pre�ram �pensar� o R como um ambiente no qual essas técnicas têm sidoimplementadas (Venables et al., 2006). Cerca de 25 pacotes (i.e. conjuntos de funções) fazem partedo sistema básico (os �recommended� packages), mas muitos outros estão disponíveis através doCRAN (via http://CRAN.R-project.org) para instalação.Uma importante diferença entre a linguagem S (e o R) e outros sistemas (e.g. SPSS® ouSAS®) reside na (muito) menor quantidade de resultados apresentados para uma qualquer análiseestatística, embora os resultados sejam guardados em objectos para posterior consulta ou utilizaçãopelo R noutras funções (Venables et al., 2006).Neste artigo, pretende-se apresentar (muito sucintamente) o R, uma linguagem de programaçãoespecializada em computação com dados, utilizando-a para analisar problemas cujo objectivo é�descrever� relações estatísticas (não-lineares) entre variáveis. Não se pretende discutir aqui osaspectos estatísticos dos resultados obtidos, apenas o modus operandi (ainda que de forma simpli-�cada).Regressão não-linear (simples)Os vários aspectos relacionados com a regressão não-linear (simples) que servem de base a esteartigo foram abordados, ainda que de forma informal e possivelmente incompleta, num artigoanterior (Esteves, 2008).Em vários domínios do conhecimento, e.g. biologia, física, química, engenharia, etc., são usadosmodelos matemáticos para descrever um conjunto de dados empíricos, genericamente
y = f(x) + εem que y é a variável dependente, x é a variável �independente� � por vezes, controlada peloinvestigador � e f(x) é uma função que pode incluir um ou mais parâmetros θ e ε são os errosaleatórios, independentes e com distribuição normal. Outra formulação, equivalente, é ŷ = f(x)(em que ŷ se lê valor esperado, ou estimado, de y). Quanto melhor f(x) se ajustar aos dados, mais�rigorosamente� descreverá aquela relação(Brown, 2001). Pretende-se ajustar a função f(x) aosdados empíricos de forma a minimizar os erros εi = (yi − ŷ). De facto, o objectivo é estimar o(s)parâmetro(s) da função f(x) de modo a minimizar a soma dos quadrados dos erros (ou resíduos),SQE � método dos mínimos quadrados. No caso de funções (ou modelos) não-lineares, e.g. ,não é possível obter as estimativas dos parâmetros num único passo, como no caso de regressõeslineares, pelo que a SQE é minimizada através dum processo iterativo (cíclico) utilizando umalgoritmo apropriado que necessita dos valores iniciais dos parâmetros θ0 (Bowen and Jerman,1995). Tradicionalmente, transformam-se as variáveis de alguns modelos não-lineares de forma alinearizar a relação e a permitir a sua análise através da regressão linear. Contudo, esta abordagem1Entretanto, será disponibilizada em breve a versão 2.9.0 (R-2.9.0-win32.exe) no sítio electrónico do programa.2



Figura 1: Aspecto da janela R Console.é válida se a(s) variável(is) transformadas se veri�cam os pressupostos da análise de regresão linear.ExemploA utilização do R com um exemplo concreto (entretanto abordado por Esteves, 2008, usando aferramenta Solver® do Microsoft Excel®) permitirá mostrar o funcionamento e demonstrar ascapacidades do software. Como se imagina, as funcionalidades não se esgotam no que aqui seapresenta.O aspecto do R ao iniciar uma sessão de trabalho em ambiente Windows® ilustra-se na 1.Para além da barra de ferramentas no topo (que permite realizar as tarefas comuns: abrir/gravar�cheiros, cortar/colar texto, instalar pacotes, �gerir� as janelas, etc.) surge uma janela (R Console)na qual se introduzem os comandos, a seguir ao sinal >.Admita-se que os dados que se pretendem analisar estão num �cheiro do Excel®. Em primeirolugar, será necessário guardar uma versão (*.txt ou *.csv)2 desse �cheiro utilizável pelo R (devemusar-se pontos, em vez de vírgulas, como separadores decimais).Na consola do R escrever (fazendo Enter no �m),> dados<-read.table(file="G:/MyArticles/ArtigosRegressaoNaoLinearExcel/RegressaoNaoLinear.txt",header=T,sep="\t")para �carregar� a informação contida no �cheiro RegressaoNaoLinear.txt para o objecto dados.(atente-se na notação <-). Os parâmetros header e sep permitem considerar os rótulos dos dadose o tipo de �cheiro de texto (neste caso separado por tabulações), respectivamente. Por sinal, aquantidade de dados envolvida poderia muito bem ser introduzida directamente no R através de2A extensão txt diz respeito a �cheiros de texto separado por tabulações enquanto a extensão csv está relacionadacom �cheiros de texto separados por vírgulas. 3



> CO2<-c(141,172,181,227,309,414,641, 936)> Prop<-c(0.25,0.34,0.34,0.68,0.85,0.99,0.98,0.99)em que c(...) permite concatenar um conjunto de dados num objecto (neste caso, CO2 e Prop) .Podemos visualizar a informação usando a função plot> plot(Prop~CO2, las=1,xlim=c(0,1000),ylim=c(0,1),pch=16,cex=1.5, xlab="CO2 (ppm)", ylab="Proporção de respostas correctas")em que Prop~CO2 descreve o �modelo� que se pretende representar (neste caso Prop em funçãode CO2) e cujos restantes parâmetros especi�cam as várias características do grá�co (las paraorientação dos rótulos do eixo dos yy, xlim e ylim para determinar os limites dos eixos, pch parade�nir o símbolo usado, cex para aumentar o tamanho relativo dos caracteres, e xlab e ylab para�legendar� os eixos) (Figura 2a). Para mais informações acerca desta (ou qualquer outra) funçãopode fazer-se> ?plot(ou então procurar com >help.search(�termo�) ou, ainda, usar a opção Help>Apropos...). Usando o botão direito do rato sobre o grá�co, é possível copiar a �gura (comometa�cheiro Windows® por exemplo) para inclusão num �cheiro do Microsoft Word®.Admita-se (por razões cientí�cas) que um modelo �dose-resposta� (logístico modi�cado)
P =

1

3
+ exp(B(T − log(x))

1 + exp(T − log(x))em que Pi é a proporção de respostas positivas do provador i, log(x) é o logaritmo do valor doestímulo x, B é o "declive" e T é o limiar para o provador i (em log(x)) é adequado para descreveros dados. Para ajustar o modelo (equação anterior) basta fazer> ajuste<-nls(Prop~(1/3+exp(B*(T-log10(CO2))))/(1+exp(B*(T-log10(CO2)))),data=data.frame(CO2=CO2,Prop=Prop),start=list(B=-10,T=2.5))em que o objecto ajuste incluirá os resultados duma regressão não-linear (através da função nls)3do modelo4 Prop~(1/3+exp(B*(T-log10(CO2))))/(1+exp(B*(T-log10(CO2))) considerando osdados (indicados para o parâmetro data sob a forma de uma data.frame5) e as estimativas iniciaisdos parâmetros do modelo descritas em start (através duma list). Os resultados do ajuste(Figura 3) podem ser consultados fazendo> summary(ajuste)É possível ilustrar o ajuste, obtendo primeiro as estimativas da variável Prop (através dafunção predict) e �desenhando-as�, em seguida, sobre o grá�co entretanto obtido (Figura 2a vsFigura 2b) usando a função lines, ou seja3Outras funções (muito) usadas são lm e aov para regressão linear (i.e. modelos lineares) e análise de variância,respectivamente.4A de�nição dos modelos em S está minuciosamente descrita em Chambers and Hastie (1992).5Neste caso, considerou-se que o utilizador introduziu directamente no sistema os dados ao invés de �carregar� o�cheiro dos dados (neste último caso, bastaria apenas indicar data=dados, no comando).4
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Figura 2: Diagramas de dispersão da proporção de respostas vs. concentração de CO2: dadosoriginais (a); modelo �dose-resposta� (logístico modi�cado); modelo �dose-resposta� com intervalosde 95% de con�ança; e modelo logístico (ver text principal).
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Figura 3: Aspecto da execução de comandos e respectivos resultados na janela R Console.> PropEsp<-predict(ajuste,newdata=list(CO2=seq(0,1000,length=100)),se.fit=T)> lines(PropEsp~seq(0,1000,length=100),lwd=2,col=6)A informação contida no objecto ajuste permite obter as estimativas para 100 valores de CO2 entre0 e 1000 (daí o parâmetro seq(1,1000,length=100) no comando acima) assim como os respectivoserros-padrão (se.fit=T) que serão guardadas no objecto designado PropEsp. A adição duma linhaespessa e magenta (lwd=2 e col=6) à Figura 2a é relativamente fácil (Figura 2b).Podem, ainda, obter-se e �desenhar-se� os intervalos de con�ança (upIC e loIC) que se calcu-lam através de , recorrendo às funções qt (para obter os valores �teóricos� de t-Student e cujosparâmetros são 1 − α/2, neste caso 0.975, e os graus de liberdade do erro, que se obtêm desummary(ajuste)$df[2]), summary(ajuste)$sigma para obter o erro-padrão das estimativas elines, respectivamente (Figura 2c).> upIC<-PropEsp+qt(.975,summary(ajuste)$df[2])*summary(ajuste)$sigma> loIC<-PropEsp-qt(.975,summary(ajuste)$df[2])*summary(ajuste)$sigma> lines(upIC~seq(0,1000,length=100),col=4)> lines(loIC~seq(0,1000,length=100),col=4)O modo mais simples de �testar� a bondade do ajuste é representar gra�camente os dados e o mo-delo ajustado (bem como os respectivos intervalos de con�ança), de modo a veri�car (visualmente)se os parâmetros obtidos numericamente descrevem, de facto, a relação entre variáveis (Figura 2c).Por outro lado, a análise grá�ca dos resíduos, e.g. resíduos vs. valores observados de X, permite�veri�car� se o modelo é adequado (os resíduos representam apenas o erro experimental se nãoapresentam tendências ou padrões). Sendo assim, obter os resíduos através de6
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Figura 4: Análise grá�ca de resíduos: resíduos vs. valores esperados (esq.); e normal probabilityplot dos resíduos (dir.).> residuos<-summary(ajuste)$reside, em seguida, representar esse grá�co em conjunto com o normal probability plot dos resíduos(Figura 4)> op<-par(mfrow=c(2,1),pty="s",las=1)> plot(residuos~predict(ajuste),pch=16,col=3,xlab="E{Proporção de respostascorrectas}",ylab="Resíduos")> abline(h=0)> qqnorm(residuos,pch=16,col=2,xlab= "Quantis da Distribuição Normal",ylab="Quantis Amostrais",main="")> qqline(residuos)> par(op)O comando par permite estabelecer o �esquema� da �gura, neste caso, os grá�cos �cam �arranjados�em 2 linhas por 1 coluna � mfrow=c(2,1) �, assim como de�nir a respectiva forma (quadrada,através de pty="s"). Ao grá�co dos resíduos vs. valores esperados de Prop (através de plot)acrescentámos uma linha horizontal ao nível de zero (através de abline) e, por �m, desenhamos onormal probability plot dos resíduos (com qqnorm e qqline).É possível testar se os resíduos se distribuem normalmente através, por exemplo, de> shapiro.test(residuos)O resultado deste comando éShapiro-Wilk normality testdata: residuosW = 0.936, p-value = 0.5719 7



O teste de sequências (ou �runs test� nos manuais anglófonos) permite testar, de forma simplese robusta, se os pontos (dados) diferem sistematicamente da curva ajustada (modelo) comple-mentando a informação do diagrama dos resíduos vs valores observados de X. No R, será neces-sário carregar alguns pacotes, tseries, quadprog e zoo (previamente instalados, através da barrade ferramentas, a partir dos �cheiros *.zip disponíveis para o Windows® em http://cran.at.r-project.org/bin/windows/contrib/) fazendo e.g.> library(tseries)Depois basta fazer> runs.test(factor(sign(residuos)))para se obter o seguinte resultadoRuns Testdata: factor(sign(residuos))Standard Normal = 0.5774, p-value = 0.5637alternative hypothesis: two.sidedPode comparar-se o ajuste de dois modelos distintos a um dado conjunto de dados confrontandoas SQE dos modelos ajustados através do teste de F. Sendo assim, depois de ajustar um modelologístico, ŷ = C/[1+Aexp(−Bx)] (Figura 2d)6 , de formulação mais generalizada do que o modelo�dose-resposta� anterior, através de> ajustes<-nls(Prop~C/(1+A*exp(-B*CO2 )),data=data.frame(CO2=CO2,Prop=Prop),start=list(A=10,B=.0025,C=1))> summary(ajustes)os resultados do teste de F obtêm-se facilmente através de> anova(ajuste,ajustes)Os passos descritos anteriormente, i.e. uma sessão de trabalho (Figura 5), podem (e, na minhaopinião, devem) ser �guardados�. Para isso, criar um �cheiro de script (através de File>Newscript), de facto um �cheiro texto, onde são �guardados� os comandos. Este �cheiro pode sercarregado noutra sessão de trabalho (através de File>Open script...) e as análises e grá�cospodem ser repetidos n-vezes (janela R Editor). O script do exemplo descrito aqui pode ser obtidono sítio electrónico do autor.Para terminar uma sessão de trabalho, primeiro �limpar� da memória os objectos criados (coma função rm) e, depois, encerrar o programa (geralmente não guardo uma �imagem� do ambientede trabalho):6Esta �gura foi obtida através de> plot(Prop~CO2,las=1,xlim=c(0,1000), ylim=c(0,1),pch=16,cex=1.5, xlab="CO2 (ppm)",ylab="Proporção de respostas correctas")> PropEsper<-predict(ajustes,newdata= list(CO2=seq(0,1000,length=100)),se.fit=T)> lines(PropEsper~seq(0,1000,length= 100),lwd=2,col=6)> uppIC<-PropEsper+qt(.975,summary( ajustes)$df[2])*summary(ajustes)$sigm> lowIC<-PropEsper-qt(.975,summary( ajustes)$df[2])*summary(ajustes)$sigm> lines(uppIC~seq(0,1000,length=100), col=4)> lines(lowIC~seq(0,1000,length=100), col=4)8



Figura 5: Aspecto duma sessão de trabalho no R.> rm(list=ls()) ; q()Considerações �naisAs �di�culdades estatísticas� relacionadas com a utilização do Excel® da Microsoft (e da respectivaferramenta Solver®) para análise de regressão não-linear (vd. Esteves, 2008) limitam a suautilização aos casos �mais simples� ou para efeitos pedagógicos. Em situações �pro�ssionais� deveusar-se software dedicado, por exemplo SPSS® ou R.Embora as características do R tornem (mais) difícil a aprendizagem, o seu carácter gratuito,o facto de ser uma ferramenta bastante poderosa com boas capacidades ao nível da programa-ção e um conjunto bastante vasto (e em constante crescimento) de packages que acrescentambastantes potencialidades estatísticas e grá�cas, o crescente interesse de utilizadores das maisvariadas formações (que se reúnem anualmente desde 2004 nas conferências useR! � este ano auseR! 2009 decorrerá em França , cf. http://www2.agrocampus-ouest.fr/math/useR-2009/) e adisponibilidade dos promotores (R Development Core Team) e da �comunidade� de utilizadores,mais ou menos avançados, ajudam (e muito) esse processo. Os vários manuais (http://cran.r-project.org/manuals.html), a página wiki (http://wiki.r-project.org/) e a mailing list de ajuda(http://stat.ethz.ch/mailman/listinfo/r-help) permitem ultrapassar a (esmagadora) maioria dasdi�culdades surgidas durante a utilização do R.AgradecimentosEste artigo muito bene�ciou dos comentários, correcções e sugestões dos colegas e leitores.
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